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AEEF

Asentaminen

7

**» Ohjelman voi ladata osoitteesta:
https://www.chemaxon.com/products/marvin/marvinsketch/

/7

** Opettaja: Akateeminen lisenssi, opettajien kannattaa rekisteoitya ja hakea
oppilaitos-lisenssin (tsekkaus vie muutaman pdivan)

/

+»» Kaikki: Varmista, toimiiko laitteessa 64-bittinen vai 32-bittinen versio (jos
64-versio ei toimi, kokeile 32-versiota)

7

** Marvin Sketch on koneelle asennettava ohjelma, Marvin JS on
selaimessa toimiva ohjelma (kuten MolView), kyseisen ty6kalu on
upotettu useaan palveluun, sen voi asentaa jopa omille www-sivuille
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d@b C h e mAXO n Support Tickets Events Jobs Contact Us Search ChemAxon... n

Products v Download v Support v Services v Aboutus v Web Store & ari.myllyviita@helsinki fi v

Home > Products > Marvin > MarvinSketch

G MarvinSketch

Introductionto ChemAxon's Drawing Tool: Marv...

ADVANCED CHEMICAL EDITOR FOR DRAWING CHEMICAL

STRUCTURES, QUERIES AND REACTIONS ——
| o ot [y o]
-

MarvinSketch allows users to quickly draw molecules through basic hd

functions on the GUI and advanced functionalities such as sprout iy

drawing, customisable shartcuts, abbreviated groups, default and user- ;:E

defined templates and context-sensitive popup menus. el ; ]
—

PRODUCT TYPE: application omoist o

INTERFACES: GUI (Desktop) % API (Java, NET ] ;"TE,__;%

AVAILABLE IN: JChem Base InstantJChem  JChem for Office
JChem for SharePaint  Plexus Suite

1O OO0 of W S o e g wh o w w of gt ws ot

Biomolecule Toolkit  chemicalize.org  KNIME

Pipeline Pilot
Chemical structure drawing

Atom and Bond properties Reaction drawing Query drawing
MarvinSketch has a rich support for atom and You can draw single step reactions in Atom lists, bond lists, not lists, generic atoms,
bond properties. Users can assign MarvinSketch by placing a reaction arrow inany  R-groups, and lone pairs are among the query
stereachemistry, charge, valence, radicals and position, pointing in any direction in relation to building features available in MarvinSketch. Link
isotopes to each atom. Single, double, triple reaction products. The structures ‘in front' of the  nodes, repeating units, pseudo atoms and
bonds and aromatic forms are supported. arrow will be recognized as reactants, structures  homology groups, S-groups with attached data
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Oppilaitos-lisenssi

é’b C h e mAXO n Support Tickets Fvents lobs Contact Us Search ChemAxon.. n

Products v Download v Support v Services v Aboutus v Web Store & arimyllyviita@helsinki fi v

Home > My ChemAxon > My Licenses

My Licenses

Created Licensed product(s) License type Software Support Comment
expiry expiry
2017-04-04 17:09:44 Marvin Applets Academic Teaching 2019-04-04 2019-04-04 academic teaching license Download
Marvin Beans
Instant JChem

30 more products...
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WWW.chemaxon.com

Products Vv Download Vv Support Vv Services Vv Aboutus Vv Web Stare (# Regjster %) Login

% BioEddie] NEW

Budapest 2016 -
BUDAPEST ARCUIES

£ d MEETING e Videos & slides from

Biomolecule Editor and . (-0 NEW our Annual Meeting in
Viewer - TRY IT NOW May 9-11 ~ Register | SOL May

ChemAxon provides cheminformatics software platforms,

annlicatinne and carvires tn nntimize the vahiie nf chemictrs




Kuten ChemSketch —ohjelman tapauksessa

Lataussivu — ennen sita rekisteroidy

Download Vv Services Vv Aboutus Vv Web Store (# Register %) Login
Home Marvin Suite
JChem Suite »
JChem for Office »

JChem for SharePoint

Instant JChem

Markush Editor

yrom 101 - Budapest 2016 -
ChemCurator 2 ' ARCHIVE
™ "Mfmumf_
& il i CTASEtAEE T R Videos & slides from

Biomolecu
Viewer-T Chemical Structure Representation Toolkit

Compound Registration

TRY OUR NEW our Annual Meeting in
| SOLUTION May

Reactor
‘heminformatics software platforms,

\/ fac . - .
Madfast roc tn Nmmtimize the valiie of chemicetrmys
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Lataussivu — hyvaksy sopimusehdot

Q]é C h e m AX O n Support Tickets Events lobs Contact Us Search ChemAxon... n

Products v Download Support v Services v Aboutus v Web Store (# Register = Lodin

Home » Download » Marvin Suite

Download Marvin Suite

Login and Accept the Terms of Usage

(<11 Accept the License Agreement. [Review EULA (Y

Select Package

L Manin Marvin for NET L Mainis
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KirjaL/Jdu tai rekist/eré')idy

) C:/?/mAxon PASS

CHEMAXON.COM
v

EMAIL

PASSWORD

Stay logged in Forgot password?
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Kirjautumisen jalkeen

: - -~ ar = n...
pport Tickets Fvents lobs Contact Us >earch ChemAxon n

at v Services v Aboutus W Web Store & arimyllyviita@helsinki fi

My ChemAxon

Download Marvln SUite My Evaluations

My Licenses
Omat Ilseps&rt/
(b | nopt

My Licenses —

Created Licensed product(s) License type Software Support Comment
expiry expiry
2017-04-04 17:09:44 Marvin Applets Academic Teaching 2019-04-04 2019-04-04 academic teaching license Diownloa d
Marvin Beans

Instant IChem

30 more products. ..
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I Download Support v Services v Aboutus v Web Store

Ohjelmien lataaminen

b Marvin Suite » Marvin
IChem Suite # | Marvin for NET
IChem for Office » | ManinJS
JChem for SharePoint
Instant JChem nse type Software Support
Markush Editor eXpiry SXpiry
¥ ChemCurator demic Teaching  2019-04-04  2019-04-04 3
ChemLocator
Chemical Structure Representation Toolkit
Compound Reqgistration




AEEF | ataaminen jatkuu

Choose File

Contents of Marvin
@ Mar\“n FUNCTIOMALITY WORKING WITHOUT LICENSE
Version 17.5.0 MolConverter Mame to Structure [single mode]

DESKTOP APPLICATIONS, API, SIGNED JARS AND EXAMPLES
FUNCTIONALITY REQUIRING ADDITIONAL LICENSE(S)

SELECT PLATFORM:

Calculator Plugins [batch mode)
®Windows [.exe) - ) :
MName to Structure (batch mode) Chinese Mame to Structure
C Marintash [.dmd)
(.dms) Markush Enumeration Document to Database

O Linux

O Marvin archive [ zip)
WINDOWS [.EXE] FILES:
@ |nstaller [exs) 32 bit

O Installer [.exe] &4 bit

O Installer with OLE Support [exe) 32 bit

Products W Download Suppart v Services v Aboutus W Web Store

m
o
m
Ll
]
m
i

0 WINDOWS [.EXE] INSTALLER

Home » Download » Marvin Suite

Reguires installed 32 bit Java.
Download file

Name Filesize Last modified

Marvin_windows_17 5.0 exe 1248 MB 2017-04-2019:24:17
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Ohjeet yms.

HTTPS://DOCS.CHEMAXON.COM/DISPLAY/DOCS/M
ARVINSKETCH+USER%2/5S+GUIDE



https://docs.chemaxon.com/display/docs/MarvinSketch+User's+Guide
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MarvinSketch —ohjeet 1

Pages

Documentation

Created by Unknown User (jvasko), last modified by Nikolett

nala on Apr 06, 2017

Welcome to ChemAxon's documentation homg page! We provide here documentation for our products. If you still have a question please create a ticket in our

Support Ticket System.
(& Are you looking for other versions?
Select other version...
DESKTOP AND WEB APFLICATIONS DISCOVERY TOOLKIT
* Compliance Checker * Calculator Plugins
» Plexus Suite » JKlustor
> JChem for Office * Reactor
> Instant JChem * Screen
> Marvin Sketch
> Marvin View ITPLATFORM TOOLKIT

* Compound Registration
> Marvin JS P g

* IChem Base

com), you agree to our use of cookies to enhance your experience. See our Privacy Policy.

MARKUSH IP
* Markush Editor

* ChemCurator

CROSS PRODUCT
* Licensing

* File Formats
* General Documentation

* Chemical Finoerorints

GOTI
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her versions -

Pages / Documentation

MarvinSketch

Created by Dora Barna, last modified by Mikolett Mihala on Aug 11, 2016

MarvinSketch User's Guide

Created by Dora Barna, last modified by Nikolett Mihala on Jul 11, 2016

Getting started Working in MarvinSketch Marvin OLE Users Guide

- Start to draw in MarvinSketch - Structure Display Options « Install and Uninstall

- Select - Customizing structure drawing - How fo Use

- Delete styles - Customize Marvin OLE editing mode

- Move / Rotate / Zoom / Scale - Drawing settings - Redirecting other Vendors' OLE objects

« Tricks and Tips - Drawing styles to Marvin OLE MarvinSkeich User's Guide
- Structure Display - Logging
- Colors + Troubleshooting and Administration

MarvinSketch Graphical User interface

.

- Implicit/Explicit Hydrogens Known Issues

- Displaying the label of carbon

« Canvas atoms » _ )
) o Additional information

= Menus of MarvinSketch = Error Highlighting in
= Toolbars of MarvinSkeich MarvinSketch Caleulator Pluine
= Pop-up Menus of MarvinSketch = Saving Display Options —— ingl i
= Status bar of MarvinSketch - Basic Editing Name 1o Structtlre
« Dialogs of MarvinSketch « Selecting a Structure o

) - Scientific Background
= Shortcuts of MarvinSketch = Copy-Paste and Drag&Drop et Checker
= Customizing MarvinSketch GUI = Geometric transformation of

.

Structure fo Name
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Asennuksen yhteydessa
tarkistetaan Javan olemassaolo

I o UH_UJ kansio ~ [ Nimi
ot UMISCI Ed %, JChem_For_Office_17.4.300.1589.x86
et Vilkinkemia D license.cxl
5¢ & OneDrive - KSLry
# KSL_koulutus
The install4j wizard could not find a Java(TM)
¢ Notebooks Runtime Environment on your system. Flease locate a
suitable 32-bit JRE. (minimum version: 1.6)
i W Tama tietokone
7 = Kuvat
# Ladatut tiedostc Locate Cancel
D Musiikki —
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Javan asennus

asennus vaatii admin —oikeudet

L

java runtime environment

Www Kuvat Uutiset

2 270 000 TULOSTA Kieli ~ Alue -

JAVA-ohjelmistokehitystd | observis.fi

Mainos - observis.fi

Vaativat asiakaskohtaset java- palvelut meilta toimitug

Download Free Java Software
https:/fjava.com/en/download

This page is your source to download or update you
Environment (JRE, Java Runtime), also known as t

Java SE Runtime Environment 8 Down
www oracle.com/technetwork/javal/javase/download
Java SE Runtime Environment & Downloads. Do yd
do you want to develop Java programs? If you want

All Java Downloads

If you want to download
Java for another computer
or Operating System, click
the link below.

All Java Downloads

Report an issue

Why am | always redirected
to this page when visiting a
page with a Java app?

» Learn more

» Report an issue

Search

Download  Help

Free Java Download

Download Java for your desktop computer now!

Version 8 Update 131
Release date April 18, 2017

Free Java Download

» What is Java? » Do | have Java? » Need Help?

Why download Java?

Java technology allows you to work and play in a secure computing environment. Upgrading to the latest
Java version improves the security of your system, as older versions do not include the latest security
updates.




AEEF Marvin Suite -asennus

Kun Java-asennus on hoidettu, kdynnistetdan (Ladatut kansiosta) Marvin —ohjelman

asennus

_ Welcome to the ChemAxon Marvin
1 Suite Setup Wizard

This will install ChemaAxon Marvin Suite on your
2 computer. The wizard will lead you step by step
through the installation.

|l
> 1 accept the terms and conditions defined in E...

Show EULA

) Marvin Suite Click Mext to continue, or Cancel to exit Setup.

MNext = Cancel
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Select Installation Type

. . . Installing
Which tYpE of installation should be pE.‘I"FDFH"IEd? Please wait while Setup installs ChemAxon Marvin Suite on your E
.‘ computer, i
) ) ) - Extracting files ...
- Select the type of installation that you want to perform. Click Next when yt|  lib\calculations-elemanal-master-6729.jar
are ready to continue. F—
It
(O Jstandard installation ‘ ‘
2 All components required for regular usage are install~4_€om-

space.
O Q Cplﬁ't . latio Completing the ChemAxon Marvin
ENE Instaaton Suite Setup Wizard

In the next step you can customize the components

installed. The initial selection is set to the standard i Setup has finished installing ChemAxon Marvin Suite
t D on your computer. The application may be launched

by selecting the installed icons.

> Click Finish to exit Setup.

) Marvin Suite
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File Edit View Insert Atom Bond Structure Calculations Services Help

¥ 10D C[X DB Q& Qe V| @
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Lisenssi

Opettajan kannattaa hankkia
"akateeminen” lisenssi.
https://www.chemaxon.com/
my-chemaxon/my-academic-

license/

Lisenssia haetaan erikseen ja
kun sen on mydnnetty, siita
tulee sahkopostiviesti.

Lisenssin myonnon jalkeen ko.
tiedoston voi ladata sivustolta
ja jakaa oppilaille.

9.5.2017

JL
((_” C h e m AX O n Support Tickets Events Jobs Contact U

Products v Download v Support Vv Services Vv Aboutus v
Desktop and Web Applications >

IT Platform Toolkit » = mrves [
Discovery Toolkit » ‘1" _, '
Chemistry Text Mining Suite » B “

Markush IP » o B

Workflow, Visualization and Analysis

Free or Discounted »

2 [*-

Academic Package

Non-Commercial
Biomolecule Editor and
Viewer - TRY IT NOW

- Commercial Academic Research License

Y I

ARI MYLLYVIITA 22



https://www.chemaxon.com/my-chemaxon/my-academic-license/

AEEF Lisenssin hyvaksyminen (asentaminen

License file:

e-mail to this di

Install license file

Please enter the location of the license file or press the Browse button to select path from the file system,
After specifying the path, press the Install button.

[= Browse...

Install

The following license

If yvour e-mail dient supports drag and drop of attachments, you can drag the license file you received by

Software

-Install license file

FEH License averview

Product license details

Create report

vemAxon licensing

Look in:

Viimeisim...

Install license file
Flease enter the location of the license file or press the Browse button to select path from the file system.
After specifying the path, press the Install button.

License file: |

” = Browse... ||

Install

e-mail to this dialog.

The following licenses will be installed by pressing the Install button:

If your e-mail dient supports drag and drop of attachments, you can drag the license file you received by

Software

- Install license fie

FEH License overview
Product license detaiis
Help
% @ Chemaxon licensing
- ChemAxon products

B )Ce

Create report

St..

Install license file

License ...

Licensee

Expiratio...
P

Support... R

Flease enter the location of the license fie or press the Bronse button to select path from the fle system.
After specifying the path, press the Install button.

license fle: | C:\Users\admin\Downloads\license.od G Eromse . ]| nstal
If your e-mail dient supports drag and drop of attachments, you can drag the license file you received by e-mail to this dislog.
The following licenses wil be installed by pressing the Install button:
Software Status License ... Licensee EXDWHUD... EUDPDVT ... Restriction Number of ... Comment
Marvin Applets [To be Academic |The 2019-04- |2018-04- |[Server Use: Not Unlimited |academic A
installed Teaching |Universi (04 04 Allowed teaching
Marvin Beans [To be Academic |The 2019-04- |2018-04- [Server Use: Not Unlimited |academic
installed Teaching |Universi (04 04 Allowed teaching
Instant JChem [To be Academic |The 2019-04- |2019-04- |B/S/P/E: Standard Unlimited |academic
installed Teaching |Universi (04 04 Server Use: Not teaching
JChem Base [To be Academic |The 2019-04- (2019-04- |Search/Min: Unlimited |[Unlimited |academic
installed Teaching |Universi (04 04 Server Use: Not teaching
Standardizer [To be Academic |The 2019-04- |2019-04- |B/S/P/E: Standard Unlimited |academic
installed Teaching |Universi (04 04 Server Use: Not teaching
Screen [To be Academic |The 2019-04- |2018-04- |Server Use: Not Unlimited |academic
installed Teaching |Universi (04 04 Allowed teaching
Reactor [To be Academic |The 2019-04- |2018-04- |Server Use: Not Unlimited |academic
installed Teaching |Universi (04 04 Allowed teaching
JKlustor [To be Academic |The 2019-04- (2019-04- B/S/P/E: Standard Unlimited |academic
installed Teaching |Universi (04 04 Server Use: Not teaching
Metabolizer [To be Academic |The 2019-04- |2018-04- |Server Use: Not Unlimited |academic
installed Teaching |Universi (04 04 Allowed teaching




EEF Asennus valmis

MarvinSketch 17.5 — O x

File Edit View Insert Atom Bond Structure Calculations Services Help

F-0|0C|X OB Q@ Q| @

Lo

| A - H

| — @ MarvinSketch c

g T Product Version: MarvinSketch 17.5.0 0

g ”IE Build Date: 2017-04-18 g

[ Internal build id: 17.5.0-6729 F
[]n Operating System: x86 Windows 10 10.0 =
(] - Character encoding: windows-1232 -

Java: Oracle Corporation Java 1.8.0_131

4 = Memory: 247 5M maximum, 38,3M total, 11,1M free o

; + Environment: Application !

E B Browser: -

t Copyright © 1998-2017 ChemAxon Ltd.

? hitp//www.chemaxon.com

OO0 0w

o0

o e it Sl v e,

P T
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Mihin MarvinSketch “taipuu”
» Molekyylien piirtdminen 2D — 3D

» Reaktioyhtaldiden kirjoittaminen
(orgaaninen kemia)
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Valikot - File

2} MarvinSketch 17.3.27

Fie et view et 2om 80nd s CHIEMSPider — [aaja datapankki, oma

New > . .

B loper. «.o | rakennekaavaeditori, ym.

i Chemicalize - hyddyntda Marvin

Save Ctrl+S

Mt wesis - )S:aa, datapankki (kts. seuraava sivu)
Import Name Ctrl+Shift+N

Import Image PUbChem -

Export to Image
Find Structure Online

1
Find Structure Online : ChemSpider
Chemicalize

PubChem

v

= Print... Ctrl+P

Multipage Settings

Print... Ctrl+P

07

Multipage Settings

Document Style >

Recent >
Close Ctrl+W

Exit Ctrl+Q

9.5.2017
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http://www.chemspider.com/
https://chemicalize.com/welcome

AEEF

7~ ROYAL SOCIETY

Home Aboutus Web APls Help & Signin w» OF CHEMISTRY

ChemSpider EXrr—

Search and share chemistry

Simple Structure Advanced History

Search ChemSpider Advertisement
MASS

SPECTROMETRY
searen Q) SOLUTIONS

Systematic Name, Synonym, Trade Name, Registry Number, SMILES, InChl or CSID 0

Learn more
What is ChemSpider? Search by chemical hames Search by chemical structure Find important data

Matches any text strings used to describe a molecule.

ChemSpider is a free + Systematic names + Create structure- + Literature Agilent Technologies
chemical structure « Synonyms based queries references

database providing + Trade names + Draw structures in « Physical properties

fast text and structure + Database the web page + Interactive spectra _

search access to identifiers » Use structure files + Chemical suppliers Spotlight

over 58 million from your

structures from computer Advertisement

hundreds of data

sources. MASS

SPECTROMETRY

9.5.2017 ARI MYLLYVIITA




AEEF Chemicalize.com

00 CALCULATION STRUCTURE SEARCH DOCUMENT SEARCH WEB VIEWER COMPLIANCE D. CREDITS: 0 + 100 ARLMYLLYVITA 3

2-butanol (. DrRAW  EKGUWNGN (8% 11 credits

Calculation is free for this molecule, because it contains at most 12 heavy atoms.

H.ec/\/‘*'a
o) H - —
30 Basic properties s 3
OH
Input 2-butanol
H3C CI_|3 Molar mass 74123 g/mal
Exact mass 74.073164942 Da
OH Formula CsHin0
Composition C(64.82%).H (13.6%). 0 (21.58%)
IDEA: y.m/v y
Empiirisen kaavan tehtavien tekemiseen!!
Structural properties ©)
Atom count 15 Hydrogen bond donor count 1
Heavy atom count 5 Hydrogen bond acceptor count 1
Asymmetric atom count 1 Formal charge 0
Rotatable bond count 1 FSP3 1.00
Ring count 0 Topological polar surface area 20.23 A°
Aromatic ring count 0 Molar refractivity 271.95 con/mol

9.5.2017 ARI MYLLYVIITA
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Databases » Upload  Services » Help  more » Today's Statistics >

_fIBIT

)

PubChem

@ BioAssay 2 O’D Compound @ Substance 2

BioAssay Tools

Structure Search

3D Conformer Tools

Limits Structure Clustering
[ | o Advanced

Classification
Try the PubChem Search Beta Upload

Download

New PubChem presents at the 253rd American Chemical Society National Meeting in

i - PubChem FTP
San Francisco (April 2-6, 2017) . Read more...
more ... B

@ [t (@ 2 [ g |2 |

Write to Helpdesk | Disclaimer | Privacy Statement | Accessibility | Data Citation Guidelines
National Center for Biotechnology Information
NLM | NIH | HHS

9.5.2017 ARI MYLLYVIITA
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Valikot - Edit

4 - MarvinSketch 17.3.27
File Edit View Insert Atom Bond Structure

i1 ") Undo Ctrl+Z f
* Redo Ctrl+Y
4 #4 Cut Ctrl+X
MV ) Copy Ctrl+C I k |. 1 22 A ” :
B e on Molekyylin “pyoritys”, paina F/
Copy As MRV Ctrl+M . . .
vrt. valinta -painike
T @ Paste Ctrl+V
NE Setectau Ctri+A
—|  InvertSelection  CtrlsShift+| - 1 _
v Transform > Drag Selection
Ll i Object ; Rotate in 2D
[ ] Align >
- Distribute > Format... Rotatein 3D  ° Around Arbitrary Axis
Align and Distribute > Around X Axis
+ Transform > @ Template Library... Ctrl+T Flip ; _
_ Object - Mirror | Around Y Axis
Format... Sl:rurce J Around Z Axis
Invert ; _
a Template Library... Ctrl+T x —armmm— [!.1 3D Plane Free 3D Rotation F7
Source Group Rotation
7% Preferences...

9.5.2017 ARI MYLLYVIITA
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Valikot — Edit — Preferences...

4 - MarvinSketch 17.3.27
File Edit View Insert Atom Bond Structure

Ly
/
NV

T
N[z
(1,
[]

=

Undo
Redo

Cut

Copy

Copy As...
Copy As MRV
Copy As Smiles
Paste

Select All
Invert Selection

Delete

Align
Distribute

Align and Distribute

Transform
Object

Format...

Template Library...

Source

Preferences...

Ctrl+Z
Ctri+Y

Ctrl+X
Ctrl+C
Ctrl+K
Ctrl+M
Ctrl+L

Ctrl+V

Ctrl+A
Ctrl+Shift+1

Ctrl+T

¥

9.5.2017

Preferences

MarvinSketch

MarvinView

! Text Checkers Services Save/load 3D Options Analysis Box
[] Highlight Valence Errors

[] Automatic Lone Pair Calculation

[] Automatic Plus Signs in Single Step Reactions

[] validate S-groups at Creation

[] Highlight Valence Errors

General Settings [_] Show Lone Pair as Line

Carbon Labels

Ligand Orders

[] Show Charge in Circle

O Always

(O Never

(@) At Straight Angles and at Implicit H Atoms
O Always

(O Never

(® On R-groups with Definitions

Help Contents Restore Defaults

ARI MYLLYVIITA
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Vapaat elektroniparit nakyviin

Preferences K ‘

MarvinSketch  [] Highlight Valence Errors El TOIMI NORMIOHJELMALLA?

[7] Automatic Lone Pair Calculation
[7] Automatic Plus Signs in Single Step Reactions
[] validate S-groups at Creation
MarvinView [] Highlight Valence Errors
General Settings [_] Show Lone Pair as Line
[] Show Charge in Circle }

Carbon Labels () Always

(O Never
(@) At Straight Angles and at Implicit H Atoms
Ligand Orders () Always
(O Never
(® On R-groups with Definitions
" Help Contents Restore Defaults = OK Cancel |
9.5.2017 ARI MYLLYVIITA 33
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Valikot - View

% - MarvinSketch 17.3.27

. . 4 - MarvinSketch 17.3.27
File Edit View Insert Atom Bond Structure Calcu
B l File Edit View Insert Atom Bond Structure Calculations Services Help

Py v Mouse mode >4
¥ OO CTA OIS Qv .| @

Zoom Level > J
. i > '
/ Structure DlsPlay ¥ Atom Symbols in 3D
> c
N\~ Colors ®  Wireframe b
Stereo > Wireframe with Knobs C ]
—' | licit d > Stick )
mp Ic }-'y rogens Ball and Stick — "
o pephde D|sp|ay > Spacefill —
NI
T Advanced > Atom Numbering 1@ off
pages > ~  Atom Properties Atom Numbers
NI=- ¥  Atom Mapping IUPAC Numbering
Toolbars > Bond Lengths
S - Lone Pai
¥ Menubar F11 onerer
[]n ' Status Bar ¥ R-groups
R-Logic
[ ] v ’ = ~  Valence
Grid Shift+F9 1% Ligand Error
O > Guidelines Ctrl+ Shift+F9 ¥ S-group Attachments
+ Editor style >

9.5.2017 ARI MYLLYVIITA
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Valikot - Insert

4 - MarvinSketch 17.3.27 Va sen reunad
File Edit View Insert Atom Bond Structure /-
vy O ‘ O Template Ctrl+T ¢ N ~ ?
Groups... i Chan |' T ¥
VR @ New Structure e e Che N|F )J
AN - Bond > —_ - H
\\ = = —
Chain > — |Stra|ght Arrow / Reaction
- Arrow > =  Retrosynthetic Arrow
i Bracket b = Equilibrium Arrow
El | y +* Resonance Arrow
T EEE #* Curved Arrow
N:[- Graphlcs ’ --#* Dashed Arrow
- T Text ++ (Crossed Arrow

e B

9.5.2017
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Bond - Pikavalikosta

tch 17.3.27 Vasen reuna

Insert Atom Bond Structure Calculations Services Help

O Template Ctrl+T Vj ’ @s @‘ 100% ‘ | VAR
Groups... _
@ New Structure /' Single
Bond § / Single # Double
Chain } / Double % Triple
Arrow Y% Triple .7 Aromatic
Bracket .7 Aromatic _
~  Single Up or Down
Electron Flow ; . — H
“~  Single Up or Down == Double Cis or Trans =
Graphics ’ Double Cis or T
== Double Cis or Trans cT
T Text aleci; Double C/T or Unspec
- ouble C/T or Unspec )
H/H\& ‘ ;#*  Single or Double
' angle = Double. &7 Single or Aromatic
A i # Double or Aromatic
.7 Double or Aromatic
< Any
Any
7\ Cocobnate /" Coordinate
9.5.2017 ARI MYLLYVIITA 36
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Valikot - Atom

327 Oikea reuna

Atom Bond Structure Calculations Service!

( Sterec > i
Charge > w
H . .
Valence ’ Valitse alkuaine
Radical > C
Isotope >
g N
M >
L Mep o
R-group >
’ R-group Attachment S
R-group Attachment Order > F
Link Nod >
ink Node p
iz Periodic Table Ctrl+E cl
Edit Properties... Br
Add S-group Attachment I
Remove S-group Attachment
NE  Label Editor
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Valikot - Bond

Bond Structure Calculations Va sen reuna
- Type ‘ E /-
—  Bold /" Single
i HEShEd !’7 Double
% Triple
Topology > 7 Aromatic
Reacting Center > | ~¥  Single Up or Down

-

8 Stereo Search == Double Cis or Trans

CT  Double C/T or Unspec
- Regenerate Bonds... ;¥ Single or Double
Allgﬂ » # Single or Aromatic
. N 7 Double or Aromatic
Ligand Order s Any
Edit Properties... /" Coordinate
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Valikot — Structure

Structure Calculations Services Help

i Clean 2D > :[* Cleanin2D Ctrl+2
P2 Cleanin3D Ctrl+3 \ %2 Clean and Arrangein 2D Ctrl+Shift+2

Directed Merge > i ¥ Hydrogenize Chiral Center
Add ’ : Clean Wedge Bonds Ctrl+B
Remove > o1 -

{ Edit Data... H  Explic ans 3 H.  Explicit Hydrogens
Edit Properties... @ Data.. N Data

| Aromatic Form > X Absolute Stereo (CHIRAL) X, Absolute Stereo (CHIRAL)
Group : Multi-Center l
Reaction s & Position Variation Bond
Mapping N No Structure
R-Logic...

Place Analysis Box Ctrl+|
Generate Name...

Name to Structure Ctrl+Shift+ N
Markush Enumeration

€Y Check Structure Ctrl+R
Auto Check

9.5.2017 ARI MYLLYVIITA




AEEF

Valikot — Structure

Structure Calculations Services Help

] Clean 2D >
I*° Cleanin3D Ctrl+3
Directed Merge ?
Add >
Remove >
Edit Data...
{ Edit Properties...
i Aromatic Form > "/"'
Group > H
Reaction >
Mapping >
R-Logic...
Place Analysis Box Ctrl+| \.\> Mame: butan-2-ol
S = Molecular weight: 74,12
MName to Structure Ctrl+Shift+N Formula: C4H1DD
Markush Enumeration
€Y Check Structure Ctrl+R
Auto Check

9.5.2017 ARI MYLLYVIITA
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Valikot — Calculations

Calculations Services Help

S

Elemental Analysis
Protonation
Partitioning
Solubility

Charge

MME

lsomers
Conformation
Geometry

Other

_i\>

9.5.2017

Elemental Analysis Options X

Type
Molecular weight

Exact malecular weight
Formula
Dot-disconnected formula
Mass spectrum
Composition

Atom count

Recognize formula in pseudo labels
Use D / T symbols for Deuterium f Tritium

[] Single fragment mode

[ ok || Cancel || Restore Defaults |

ARI MYLLYVIITA

3 Elemental Analysis

Meolecular weight: 74,123
Exact molecular weight: 74,073164942

Formula: C4H1|:|0

Dot-discomnected formula: C‘Hwt]

Composition: C (64,82%), H (13,6%), O (21,58%)
Atom count: 13

Mass spectrum [m/z: relative abundance]:

74: 1.00 75: 0.04

5 8 B 8 8 2 8 8 3

=
t

=
T4
-




AEEF
Valikot — Calculations - Charge

[} Charge X

Bond Structure Calculations Services Help

G] ‘ F Elemental Analysis g

Protonation »
Partiticning »
Solubility »
Charge : Charge
MNMR ; Polariza
Isormers 3 Orbital
Confoermation ; Dipole |
Geometry *
Other >

Dedmal places |3 .,

Type Total
Charges of implicit hydrogens
Take resonant structures
|:| Take major microspecies

at pH 7.4
Display in MarvinSpace

Cancel Restore Defaults
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AEEF
Valikot — Calculations - Charge

Bond Structure Calculations Services Help

C o6 ‘ c Elemental Anslysis @) [} Orbital Electronegativity X
Protonation » G [@]]
Partiticning »
Solubility ?
Charge L Charge
MMR Polarizability
Isormers Orbital Electronegativity
Conformation Dipole Moment Calculation
Geometry »
Other >
Orbital Electronegativity Options X
Decimal places
Type Fi o

Take remna?&s —

[ ] Take major microspecies

at pH 7.4 |

oK Cancel Restore Defaults
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AEEF
Valikot — Calculations - Charge

| £| Dipole Moment - O X

Bond Structure Calculations Services Help

X G:] G] ‘ C Elemental Analysis g

Protonation ]

Partiticning »

Solubility »

Charge : Charge

MMR : Polarizability

Isormers 3 Orbital Electronegativity

Conformation Dipole Moment Calculation
Geometry »

Other *

Dipole Moment information:
Dipole: 1,65 Debye
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